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License Agreement 
 

 

THIS IS A SINGLE COPY SOFTWARE LICENSE granted by MinServ (Mineral Services), (the 

ñCompanyò).  The Software is licensed to you as the end user. It is not sold. 

 

1. The Software enclosed in this package is copyrighted material. Once you have paid the required 

single copy license fee, you may use the Software for as long as you like provided you do not violate the 

copyright and if you follow these simple rules: 

 

(a) You may use the Software on any computer for which it is designed so long as not more than 

one (1) person uses it at any one time. You must pay for additional copies of the Software if 

more than one (1) person will be using it at the same time on one (1) or more computers. 

 

(b) The Software is copy protected. You may make no more than one (1) copy of the Software for 

backup purposes, and all such copies, together with the originals, must be kept in your 

possession or control. You may only transfer the Software to another user if you transfer the 

originals and all copies retaining no copies for yourself. 

 

(c) You may not make any changes or modifications to the Software, and you may not decompile, 

disassemble, or otherwise reverse engineer the Software. You may not rent or lease it to others. 

You may not use it on a computer network unless only one (1) person can use it at a time. 

 

(d) If this copy of the Software is an update to an earlier version of the Software, it is provided to you 

on an exchange basis. The acceptance of an updated copy of the Software shall result in the 

voluntary termination of your earlier License and of all rights to use or transfer the earlier version 

of the Software to another. 

 

2. Use of this Software for business solicitations and/or mailings of any kind may be contrary to the 

laws of Australia or other governments, or the rules and regulations of certain governing bodies, and the 

Company disclaims any liability for any improper use or misuse of the Software. 

 

3. In no case shall the Company's liability exceed the price paid for the product and for the license 

fee to use the Software. 

 

4. This License constitutes the entire agreement and understanding between the parties and 

supersedes any prior agreement or understanding whether oral or written, relating to the subject of this 

License. This License may only be modified by a written agreement signed by the Company. 
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Introduction 
 

About WinRock 

 

   WinRock is a petrology/geochemistry and classification program for Windows. WinRock plots IUGS 

igneous classification diagrams, including QAPF diagrams, plus sandstone, general purpose ternary and 

XY diagrams. Each diagram contains separate Labeled fields corresponding to individual rock types with 

data and rock names listed in separate tables. There are optional tick marks, labels, titles, fonts and 

fields, plus a choice of symbols and colors. Data can be marked and Labeled using the drawing tools. 

There is a built in spreadsheet with multiple document interface and clipboard support. .   

WinRock Features 

Built in Spreadsheet 

 

   WinRock has an inbuilt spreadsheet for entering and editing data.  The spreadsheet reads and writes 

tab delimited ASCII files, compatible with most spreadsheets and text editors. 

Standard Classification Diagrams 

 

   A set of standard rock classification diagrams are included: carbonatite, charnockite, melilite volcanic, 

melilite plutonic, QAPF general plutonic, QAPF general volcanic, PlagPxOl, PlagPxHbl, PlagOpxCPx, 

OlOPxCPx, OlPxHbl, general sandstone, Arenites and Wackes.   

 

A number of geochemical classification diagrams, including, TAS plutonic and volcanic, Jensen Cation 

and tectonic classification plots are available. 

CIPW Norms 
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  CIPW normative minerals for normal rocks can be calculated. Alkali norm for alkaline rocks and 

carbonatites can be calculated. 

Petrology Plots 

 

  Petrology diagrams, including harker, ternary and spider plot diagrams are included  

Diagram Manipulation 

 

   Many options are available for plotting data.  A choice of symbols, labels and diagram  title is available 

to customize the diagram.  Labels can be placed on any number of data points.  On screen control 

relates each highlighted data point to a set of data listed in a table. 

Printing 

 

   Publication quality diagrams can be obtained with a laser printer.  Diagrams can be customized with a 

choice of labels and symbols.  Select from small, medium or large diagrams.  Print symbol descriptions 

with the diagram. 

Getting Started 

 

   WinRock requires a minimum system configuration for effective results.  The system requirements are: 

 

  Windows 2000, XP, Vista, Windows 7, Server 2008 

 Internet Explorer 6 SP1   

 Mouse 

  Devices supported by Windows 

  Printer supported by Windows. 

 

 For automatic installation, proceed as follows: 

 

1. Start Windows and place CD into CD Drive 

2. Go to the Run Option on the Start Menu and Click on Browse 

3. Open (CDROM)D:\Geolbases\Disk1\Setup.exe to Setup Geolbases  or 

(CDROM)D:\WinRock\Disk1\Setup.exe to Setup WinRock 

4. Setup will start. You should not have any problems, but if you do have problems, you may 

have to update with a service pack and Setup may not work correctly. Service packs are 



WINROCK © Mineral Services 
 

 

 

 
 

Page 3 

 

 

available from the Microsoft Windows Download Site : 

http://www.microsoft.com/windows/downloads/default.asp.  Setup will start and copy the program 

files to the PCôs Hard Disk 

5. After Setup has concluded, you will get a [App] Setup was Completed Successfully 

message. 

6. To Start WinRock, go to the WinRock Menu and click on WinRock.  Enter your 

registration details in the Registration Window. 

7. To Start Geolbases go to the Geolbases Menu and click on Start Here.  The initial 

registration form will display.  You should complete this form, otherwise the programs may not 

run properly.  Click on Geolbases to get the Database Manager and access to the other 

databases.  Click on Options in the File Menu and enter the path of each database.  Your 

password for the Geolbases is not required. 

 

 

   Installation will now proceed.  During installation, the user is prompted for a directory.  If this is ignored, 

a new directory called WinRock will be created.  If a directory path is entered, a new directory with this 

name will be created.  The user will be notified when installation is complete.  A new Start Menu Item 

containing the WinRock and WinRock HELP is created.  Click on WinRock to start the program. 

http://www.microsoft.com/windows/downloads/default.asp
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Tutorial 
 

Introduction 

 

   WinRock has a standard Windows interface, reducing the number of new procedures to learn.  Before 

starting the exercise, WinRock must be installed on the userôs hard drive and opened ready to use.  See 

Getting Started in the Introduction for information on how to install WinRock.  A sample data file called 

comrie.rok is provided for use with the tutorial exercise.  If help is required, press F1 to access online 

help.  Alternatively, pull down the Help menu and select Contents. 

Getting To Know WinRock 

 

   To load the comrie.rok data file, click the Open toolbar button or select Open from the File menu.  The 

Open common Dialog box will pop up.  Select comrie.rok in the directory containing winrock.exe.  If the 

user, during installation specified no directory, the default directory name is WinRock 

 

   Before proceeding with a plot, select a rock group from the Modal Menu.  The user should set the 

correct rock group.  Pull down the Modal Menu and select General Plutonic QAP. The selected rock 

group is displayed in the bottom left hand corner of the spreadsheet. 

Plotting Data 

 

   Pull down the Options Menu and select Plot Classification. Select a QAP diagram and click the Plot 

button.  A ternary diagram of QAP will appear on a new form.  To plot a label, Click row #3 in the grid list. 

Hint: 

               Use the toolbar as a short cut to access some options. 
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 The corresponding data point on the diagram will now be highlighted. When finished, click the OK button 

and you will be returned to the Spreadsheet window.   

Entering Data 

 

   WinRock has its own built in spreadsheet but you may find it easier to use a spreadsheet or text editor 

you are familiar with to enter your data.  Select New from the File menu to start new data files.  Pull down 

the Modal Menu and select general plutonic QAP.  The appropriate column headings are placed in the 

spreadsheet.  Data is entered in each cell by simply typing the value and pressing <enter>.  Use the scroll 

bars, arrow, page up and page down keys to navigate through the spreadsheet.  To edit a cell, press 

<enter> for the cell you want to edit and use the backspace/delete/insert keys to edit the text.  When 

finished editing press <enter> the new value will appear in the spreadsheet.  Whole rows can be inserted 

and deleted using the Insert Row and Delete Row toolbar buttons.  Blank lines are not permitted between 

data. Column headings are used for reading column data. Be sure a column heading exists for 

each column of data in the spreadsheet, beginning with column 1 and ending with the last 

column of data.  

 

   Enter the following data: 

 

Sample # Quartz Al Felds Plag 

 

134223  25 20 55 

134225  12 36 52 

134226  7 56 37 

134227  47 21 32 

 

   To edit a cell, go back to Row 2, Col 1 and press <enter>.  Type 134224 to replace 134223 and press 

<enter>. 

    

Hint: 

               Use the mouse to navigate through the spreadsheet.  Click a cell to change the 

current cell or click on the scroll bars to display out of view data.  To begin editing a cell, 

double click the mouse or type a character. 
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   When you have finished using the program, select Exit from the File menu. 

Analyzing a Geochem File 

   Open one of the data files containing whole rock chemical analyses from the winrock.exe directory i.e. 

basalt.rok or trace.rok.  The data file contains a standard set of whole rock analyses.  Compositional 

variation diagrams and classification diagrams can be plotted to determine genetic and compositional 

information about the samples.  Open the GeoChem Menu and click on Total Analyses incl. H2O.  

Various petrological indices are calculated and displayed in the spreadsheet.  The mafic and felsic 

indices and solidification index are calculated.  Plotting Total Alkali and Oxides vs SiO2 i.e. Na2O+K2O 

vs SiO2 may give information about genetically similar magmas.  Select the Geochem Menu and click on 

CIPW Norm wt%.  A CIPW normative mineral assemblage with petrological indices is calculated.  The 

norms can be plotted on standard classification diagrams i.e. PlagPxOl to classify the rocks.  In addition, 

the AMF and QML indices can be plotted on Ternary diagrams to give genetic and compositional 

information. Select the Geochem Menu and Chemical Classification.  Select Classify Volcanic Rocks 

from the Options Window and click on calculate.  Data will automatically be classified and rocknames will 

be placed in the spreadsheet. 

 

The procedure for plotting a TAS diagram is as follows:  

 

1. Load the Geochem Data into the spreadsheet or type in the data  

- Use Insert Whole Rock Headings Or Converté from Geochem Menu for correct columns.  

2. Define the columns containing the X and Y data  

- TAS Diagrams Automatically Assign the appropriate columns using the current spreadsheet, provided 

the data is in WinRock Whole Rock Chemistry Format. 

3. Select Plot Classification from the Plot Menu  

4. Select TAS-Volcanic in the Diagram List  

- Accept all default values  

5. Click on Plot  

6. The TAS Diagram should be displayed 

 

The procedure for plotting a QAP diagram is as follows:  

 

1. Load Data into the spreadsheet or type in the data  

- Use Insert Modal Headings QAP from Modal Menu for correct columns.  

2. Define the columns containing the X ,Y and Z data  

Use Define Columns in the Options Menu  

- Set X value to the column containing Q 

-This is Column 5 for the default comrie.rok file supplied  
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-Set Y Column to the column containing A  

-This is Column 6 for the default comrie.rok file supplied.  

-Set Z Column to the column containing P  

-This is Column 7 for the default comrie.rok file supplied.  

3. Select Plot Classification from the Plot Menu  

4. Select QAP-Plutonic in the Diagram List  

- Accept all default values  

5. Click on Plot  

6. The QAP Diagram should be displayed 
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WinRock Menu System 
 

Introduction 

   When WinRock is started the first screen displayed contains a spreadsheet and menu system.  The 

menu system provides access to all the features of WinRock.  Standard Windows menu items; such as, 

File, Edit and Help are included.  Other menu items provide access to the specialized features of 

WinRock. 

File Menu 

 

   The File Menu provides many standard file management options. 

New Command 

 

   Starts a new spreadsheet  

Close Command 

 

   Closes the current spreadsheet. 

Open Command 

 

   Provides access to the Open common Dialog box.  Opens a new file.  Select the directory and file and 

click OK.  Clicking the Open toolbar button can also open a file. 

Save Command 

 

   Saves a file to disk.  The default filename is the current filename.  The same result is obtained by 

clicking the Save toolbar button. 

Save As Command 
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   Saves a file to disk in a directory and filename specified by the user.  A Save As Dialog box pops up for 

the user to enter filename and directory path information. 

Save As Command 

 

   Saves a file to disk in a directory and filename specified by the user.  A Save As Dialog box pops up for 

the user to enter filename and directory path information. 

Import Command 

 

   Imports a text file.  Select the type of file to import: 

Space Delimited 

Comma Delimited 

Tab Delimited 

Semi Colon Delimited 

Fixed Width 

Specify the number of lines to skip at the beginning of the file to avoid importation of file 

headings into the spreadsheet. 

Print Setup Command 

 

   Specifies printer settings available to the user.  A Print Setup Dialog box pops up with several options to 

control the printer.  Use this option to set the default printer and various printer settings. 

Exit Command 

 

   Quits the application. 

Edit Menu 

 

   The Edit Menu provides access to several standard commands for editing the spreadsheet. 

Undo Command 

 

   Undoôs the previous editing action in the spreadsheet. 
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Copy Command 

 

   Copies selected text in the spreadsheet to the clipboard without deleting.  Highlight the text to be copied 

by dragging the mouse or holding down the shift key and clicking cells.  Highlighted text must be 

contiguous.  Select Copy to copy the selected text to the clipboard.  Use Paste to paste text from the 

clipboard to the spreadsheet.  Use Cut to remove highlighted text from the spreadsheet to the clipboard. 

Cut Command 

 

   Copies selected text from the spreadsheet to the clipboard and clears the highlighted area in the 

spreadsheet.  Highlight text to be cut by dragging the mouse or holding down the shift key and clicking 

cells.  Select Cut from the edit menu to transfer selected text to the clipboard.  Use Paste to retrieve cut 

text from the clipboard.  Use Copy when you want to copy text to the clipboard without deleting the 

highlighted text. 

Paste Command 

 

   Retrieves text from the clipboard and pastes it into selected cells.  Highlight cells that are to receive the 

incoming text by dragging the mouse or holding down the shift key and clicking cells.  Highlighted cells 

must be contiguous.  Select Paste from the Edit menu to transfer text from the clipboard to the 

spreadsheet..  Any text that already exists in the highlighted cells will be replaced.  If the number of 

selected cells are fewer than will hold the clipboard text, the rightmost text from the clipboard will be 

truncated to fit the selected cells.  If the number of cells selected exceed the length of the clipboard text, 

the remaining cells will be cleared.  Use Copy and Cut to send text to the clipboard. 

Sort Menu 

 

   The Sort Menu allows the user to sort data in the spreadsheet.  A new window opens asking for the 

column number to sort.  Click on Sort to sort the spreadsheet. 

Search Menu 

 

    The Search Menu allows the user to find and replace user specified text. 

Find Command 
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   Finds a user specified search text in the spreadsheet.  A pop up Search/Replace Dialog box prompts 

the user for the search text.  Enter the exact search text and click OK to proceed with the search. 

Find Next Command 

 

   Repeats a search using the previous specified search text. 

Replace Command 

 

   Provides access to the search/replace Dialog box for searching and replacing spreadsheet text.  Select 

from: 

 Replace All - replace all occurrences of the search text 

 with the specified replace text. 

 

 Replace - replaces contents of the current cell with the 

 specified replace text.       

Modal Menu 

 

    This menu selects the type of modal diagram to be plotted and automatically places the appropriate 

column headings into the spreadsheet.  WinRock uses standard classification diagrams and tables.  See 

Literature References for publications dealing with rock classification.  Modal mineralogy headings for 

entering mineral modes will automatically be placed into the spreadsheet by clicking on the appropriate 

rockgroup.  Rocks can also be classified by calculation  using the Calc Modal Classification Command.  

The correct rockgroup must be selected and data entered properly for the calculation to work correctly. 

 

     Select from some of the following classification diagrams: 

 

 Carbonatites - CaO/MgO/FeO+Fe2O3+MnO chemical classification of carbonatites. 

 Charnockites - Quartz/Alkali Feldspar/Plagioclase charnockites. 

 Melilite Plutonic - Melilite/Olivine/Clinopyroxene melilite plutonic rocks. 

 Melilite Volcanic - Melilite/Olivine/Clinopyroxene melilite volcanic rocks 

 General Plutonic QAPF- Quartz/Alkali Feldspar/Plagioclase/Foids plutonic rocks. 

 General Plutonic QAP - Quartz/Alkali Feldspar/Plagioclase plutonic rocks. 

 General Plutonic FAP - Foid/Alkali Feldspar/Plagioclase plutonic rocks. 

 Mafic PlagPxOl - Plagioclase/Pyroxene/Olivine mafic rocks. 

 Mafic PlagOpxCPx - Plagioclase/Orthopyroxene/Clinopyroxene mafic rocks 

 Mafic Plag/Px/Hbl - Plagioclase/Pyroxene/Hornblende mafic rocks 
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 Ultramafic Ol/OPx/CPx - Olivine/Orthopyroxene/Clinopyroxene ultramafic rocks. 

 Ultramafic Ol/Px/Hbl - Olivine/Pyroxene/Hornblende ultramafic rocks. 

 Volcanic QAPF - Quartz/Alkali Feldspar/Plagioclase/Foids volcanic rocks 

 Volcanic QAP - Quartz/Alkali Feldspar/Plagioclase volcanic rocks. 

 Volcanic FAP - Foids/Alkali Feldspar/Plagioclase volcanic rocks. 

 General Sandstones - Quartz/Clay/Feldspar general sandstones. 

 Sandstones Arenites - Quartz/Feldspar/Rock Fragments for sandstones <15% clay. 

 Sandstones Wackes - Quartz/Feldspar/Rock Fragments for sandstones >15% clay. 

Calc Modal Classification 

 

   Automatically classifies rocks using modal mineralogy and places the rocknames into the spreadsheet. 

 Select a rockgroup from the Modal Menu and click on Modal Classification to classify the rocks. This 

option is only available for felsic, mafic and ultramafic plutonic, volcanic and charnockite rockgroups and 

sandstones.  

Insert Headings 

 

   Inserts mineral headings into the spreadsheet for plotting classification diagrams.  For ternary 

classification diagrams, each mineral corresponds to the X, Y or Z axis. Enter mineral data under the 

appropriate heading to plot your diagram. Before plotting, ensure the spreadsheet columns are assigned 

to the correct axes using the Define Columns Command in the Options Menu. 

Modal Headings 

 

Automatically places mineral headings into the spreadsheet for entering modal compositions. 

Reports 

 

   Automatically loads a petrographic report template for routine petrographic analyses.  The reports can 

be used "as is" or customized to the users requirements.  Reports can be saved or cut and pasted into 

spreadsheet applications for further formatting. Reports are also supplied already formatted in Excel '97 

format. They are located in the application directory. 

 

Report Templates Supplied: 

Igneous Rocks 

Pyroclastic Rocks 

Metamorphic Rocks 
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Sedimentary Rocks 

Limestones 

Ore Minerals 

GeoChem Menu 

 

Total Analyses Command 

 

Calculates Totals for chemical analyses.  Several Indices are also calculated: 

 

Silica Grade ï Acid, Intermediate, Basic, Ultrabasic. 

Acid >= 63% 

Intermediate >=52% And <63% 

Basic >= 45% And <52% 

Ultrabasic >= 35% And < 45% 

 

Na2O+K2O - Total Alkali 

 

FeOt  - Total Iron. Calculates Fe2O3/1.11134 +  FeO and places it into the FeOt column.  

 

Mg Ratio or Mg# - Atomic (Mg/Mg+Fe) * 100 

 

Solidification Index (Kuno, 1959)) -  

100 * (MgO/(MgO+Fe2O3+FeO+Na2O+K2O))  

 

Felsic Index - ((Na2O+K2O)/(Na2O+K2O+CaO)) * 100 

 

Mafic Index - ((FeO+Fe2O3)/FeO+Fe2O3+MgO)) * 100 

 

CMAS (Cox, Bell and Pankhurst (1979) - 

C = (CaO - 3.33 * P2O3 + 2 * Na2O + 2 * K2O) * 56.08 

M = (Fe2O3 + MnO + NiO + MgO - TiO2) * 40.31 

A = (Al2O3 + Cr2O3 + Fe2O3 + Na2O + K2O + TiO2) * 101.96 

S = (SiO2 - 2 * Na2O - 2 * K2O) * 60.09 

All in mol proportions of major oxides 

Recalculated as % 

 

Totals can be calculated with or w/o H2O and with or w/o LOI (Loss on Ignition)  
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Chemical analyses can be normalized 100% volatile free using the Recalculate 100% Volatile Free 

Command. Analyses are recalculated and normalized without H20 or LOI. 

 

Recalc to a New Sum 

 

Recalculates major element whole rock chemistry to a new user defined total 

 

Convert 

 

Selecting Convert from the Geochem Menu will start the spreadsheet conversion routine. The current 

spreadsheet will be converted to WinRock whole rock spreadsheet format for use with WinRock's 

Geochem functions. The spreadsheet conversion matches the column headings in your imported file to 

WinRock whole rock headings to perform the conversion. As most geochem files use standard whole 

rock chemistry and trace element abbreviations, conversion is usually not a problem 

 

Insert Headings Command 

 

Inserts chemical analysis or multi element headings into the spreadsheet 

 

   Each element is assigned to a specific column. For the calculations to work correctly, these columns 

must be used ñas isò, in their pre-defined format. Do not change the whole rock geochemistry headings.  

For multi element geochemistry, the text in the column headings can be changed to suit your analysis, 

but there must be the same number of columns for the calculations (Totals) to work correctly. 

 

The geochem columns are defined in the following format: 

 

Col1: Sample # 

Col2: Rockname 

Col3: Symbol 

Col4: Color 

Col5: SiO2 

Col6: TiO2 

Col7: Al2O3 

Col8: Fe2O3 

Col9: FeO 

Col10: MnO 

Col11: MgO 
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Col12: CaO 

Col13: Na2O 

Col14: K2O 

Col15: P2O5 

Col16: H2O+ 

Col17: H2O- 

Co18: CO2 

Col19: CL 

Co20: F 

Col21: S 

Co22: SO3 

Col23: Cr2O3 

Co24: ZrO2 

Col25: Total 

Co26: LOI 

Col85: Silica Grade 

 

For multi element geochemistry, the columns have the following format: 

 

Col1: Sample # 

Col2: Rockname 

Col3: Symbol 

Col4: Color 

Col5: Au 

Col6: Ag 

Col7: As 

Col8: Cr 

Col9: Cu 

Col10: Fe 

Col11: Hg 

Col12: Mn 

Col13: Mo 

Col14: Ni 

Col15: Pb 

Col16: Pt 

Col17: Sb 

Co18: Sn 

Col19: Ti 
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Co20: U 

Col21: V 

Co22: Zn 

Col23: Zr 

Col25: Total 

Co26: LOI 

 

Chemical Classification 

 

    Classifies rocks by calculating whole rock chemistry and normative minerals and places the 

rocknames into the spreadsheet.  Only available for plutonic and volcanic rocks. Select a Classification 

Scheme to classify the rocks. The calculation uses the full CIPW norm.   

Enter the iron ratio for norms if required. Select Use Standard Values if a TAS classification is calculated. 

 This options uses standard Fe2O3 ratios for specific rocktypes, as listed under the Set Fe Ratio heading. 

 

   The spreadsheet can be slow to read large files. If this is the case, better performance can be obtained 

by deleting unused columns (setting columns to empty). For example, when performing a chemical 

classification on a whole rock chemistry file, it is possible to delete all trace element columns (trace 

elements are not required in the calculation) before the operation to improve performance. 

    

CIPW Norm (Standard) Command 

 

   Calculates CIPW normative minerals for normal igneous rocks in wt% or mole%. Calculations 

performed in wt% sum to the water free total of the original analysis in wt%, equivalent to the original 

CIPW Norm; whereas, mol% sums to 100, following the method of Barth-Niggli's Molecular Norm 

(Catanorm).  The additional chemical components CO2, Cl, F, S, SO3, CR2O3 and ZRO2 are not used 

in this calculation. If Adjust Fe Ratio is selected, the CIPW Fe is proportioned according to this formula: 

 

FE = Fe2O3 / 1.1113 + FeO: Fe2O3 = FE * FR * 1.1113:FeO = FE * (1 - FR) 

 

Where: 

FE = Total Fe 

FR = Fe Ratio 

 

The Fe Ratio calculation used here follows that of Middlemost (1989).  If Adjust Fe Ratio is not selected, 

the CIPW Fe uses the Whole Rock Analysis Fe2O3 and FeO in wt% 

 

 The following compositional factors are also calculated: 



WINROCK © Mineral Services 
 

 

 

 
 

Page 17 

 

 

 

1. AMF - the ratio Na O + K O/MgO/FeOt (Irvine and Baragar, 1971) 

 

2. QML - the ratio silica(Q)/mafic(M)/leucocratic(L)  components (Johanssen, 1938) 

 

3. Quartz/Albite/Orthoclase ratio if >70% felsic minerals are present 

 

4. Differentiation Index of Thornton and Tuttle(1960) 

DI= normative q + or + ab + ne + ks + lc 

 

5. Larsen Index (Larsen, 1938 and Cox et al., 1979) 

1/3SiO2 + K2O ï FeO + MgO + CaO 

 

6.   Alkalinity Ratio (Wright, 1969) 

(Al2O3 + CaO + Na2O + K2O)/(Al2O3 + CaO  - Na2O ï K2O) 

If SiO2>50% and 1.0-K2O/Na2O<2.5 Then 

(Al2O3 + CaO + 2Na2O)/(Al2O3 + CaO  - 2Na2O) 

 

7.  CMAS (Cox, Bell and Pankhurst (1979) - 

C = (CaO - 3.33 * P2O3 + 2 * Na2O + 2 * K2O) * 56.08 

M = (Fe2O3 + MnO + NiO + MgO - TiO2) * 40.31 

A = (Al2O3 + Cr2O3 + Fe2O3 + Na2O + K2O + TiO2) * 101.96 

S = (SiO2 - 2 * Na2O - 2 * K2O) * 60.09 

All in mol proportions of major oxides 

Recalculated as % 

 

Normative mineral abbreviations: 

 

Q - quartz 

ap - apatite 

or - orthoclase 

ab - albite 

an - anorthite 

ne - nepheline 

lc - leucite 

kp - kaliophyllite 

hl - halite 

th - thenardite 
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ac - acmite 

il - ilmenite 

mt - magnetite 

hm - hematite 

tn - sphene 

ru - rutile 

ns - Na metasilicate 

ks - K metasilicate 

cs - dicalcsilicate 

wo - wollastonite 

ol - olivine 

di - diopside 

hy - hypersthene 

pv - perovskite 

c - corundum 

pr - pyrite 

 

CIPW Norm (Full) Command 

 

   Calculates CIPW normative minerals with some additional components in wt% or mole%. Calculations 

performed in wt% sum to the water free total of the original analysis in wt%, equivalent to the original 

CIPW Norm; whereas, mol% sums to 100, following the method of Barth-Niggli's Molecular Norm 

(Catanorm). The additional chemical components CO2 ,Cl, F, S, SO3, CR2O3 and ZRO2 are used in this 

calculation if available. If Adjust Fe Ratio is selected, the CIPW Fe is proportioned according to this 

formula: 

 

FE = Fe2O3 / 1.1113 + FeO: Fe2O3 = FE * FR * 1.1113:FeO = FE * (1 - FR) 

 

Where: 

FE = Total Fe 

FR = Fe Ratio 

 

The Fe Ratio calculation used here follows that of Middlemost (1989).  If Adjust Fe Ratio is not selected, 

the CIPW Fe uses the Whole Rock Analysis Fe2O3 and FeO in wt% 

 

The following compositional factors are also calculated: 

 

1. AMF - the ratio Na O + K O/MgO/FeOt (Irvine and Baragar, 1971) 
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2. QML - the ratio silica(Q)/mafic(M)/leucocratic(L)  components (Johanssen, 1938) 

 

3. Quartz/Albite/Orthoclase ratio if >70% felsic minerals are present 

 

4. Differentiation Index of Thornton and Tuttle(1960) 

DI= normative q + or + ab + ne + ks + lc 

 

6. Larsen Index (Larsen, 1938 and Cox et al., 1979) 

1/3SiO2 + K2O ï FeO + MgO + CaO 

 

6.   Alkalinity Ratio (Wright, 1969) 

(Al2O3 + CaO + Na2O + K2O)/(Al2O3 + CaO  - Na2O ï K2O) 

If SiO2>50% and 1.0-K2O/Na2O<2.5 Then 

(Al2O3 + CaO + 2Na2O)/(Al2O3 + CaO  - 2Na2O) 

 

7.   CMAS (Cox, Bell and Pankhurst (1979) - 

C = (CaO - 3.33 * P2O3 + 2 * Na2O + 2 * K2O) * 56.08 

M = (Fe2O3 + MnO + NiO + MgO - TiO2) * 40.31 

A = (Al2O3 + Cr2O3 + Fe2O3 + Na2O + K2O + TiO2) * 101.96 

S = (SiO2 - 2 * Na2O - 2 * K2O) * 60.09 

All in mol proportions of major oxides 

Recalculated as % 

 

Normative mineral abbreviations: 

 

Q - quartz 

ap - apatite 

or - orthoclase 

ab - albite 

an - anorthite 

ne - nepheline 

lc - leucite 

kp - kaliophyllite 

hl - halite 

th - thenardite 

cc - calcite 

ac - acmite 
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il -ilmenite 

mt -magnetite 

hm -hematite 

tn -sphene 

ru -rutile 

zn -zircon 

fl - fluorite 

cm -chromite 

cs -dicalcsilicate 

ns - Na metasilicate 

ks - K metasilicate 

wo - wollastonite 

ol - olivine 

di - diopside 

hy - hypersthene 

pv - perovskovite 

c - corundum 

pr - pyrite 

 

Alkali-Carb Norm Command 

 

Calculates normative minerals for strongly alkaline and carbonatite rocks in wt% or mole%. Suitable for 

nephelinites, ijolites and carbonatites. The norm is derived from the alkali norm of Le Bas (1973). 

Originally presented by McBirney et al. (1993).  Calculations performed in wt% sum to the water free total 

of the original analysis in wt%; whereas, mol% sums to 100. The additional chemical components CO2, 

Cl, F, S, SO3, CR2O3 and ZRO2 are used in this calculation if available. If Adjust Fe Ratio is selected, 

the CIPW Fe is proportioned according to this formula: 

 

FE = Fe2O3 / 1.1113 + FeO: Fe2O3 = FE * FR * 1.1113:FeO = FE * (1 - FR) 

 

Where: 

FE = Total Fe 

FR = Fe Ratio 

 

The Fe Ratio calculation used here follows that of Middlemost (1989).  If Adjust FeRatio is not selected, 

the CIPW Fe uses the Whole Rock Analysis Fe2O3 and FeO in wt% 

 

Normative mineral abbreviations: 
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Q - quartz 

ap - apatite 

or - orthoclase 

ab - albite 

an - anorthite 

ak - akermanite 

mel - melanite 

nc - sodium carbonate 

kc - potassium carbonate 

ma - magnesite 

ba - baddeleyite 

ge - gehlenite 

cn - carnegieite 

ne - nepheline 

ka - kalsilite 

lc - leucite 

kp - kaliophyllite 

hl - halite 

th - thenardite 

cc - calcite 

ac - acmite 

il - ilmenite 

mt - magnetite 

hm - hematite 

tn - sphene 

ru - rutile 

zn - zircon 

fl - fluorite 

cm - chromite 

ns - Na metasilicate 

ks - K metasilicate 

wo - wollastonite 

ol - olivine 

di - diopside 

hy -hypersthene 

pf - perovskite 

c - corundum 

pr - pyrite 
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Adjust Fe Ratio Command 

 

The ratio Fe3+/Total Fe. The Fe Ratio can be redefined using the Adjust Fe Ratio command.  The Fe 

Ratio is used for calculating CIPW norms. The Fe Ratio calculation used here follows that of Middlemost 

(1989).  Use the following values for some common compositions: 

Foidite 0.1 to 0.4 

Picrite 0.15 to 2 

Komatiite 0.15 to 2 

Miemechite 0.15 to 2 

Boninite 0.35 to 4 

Picrobasalt 0.15 

Basanite 0.2 

Basalts 0.2 

Basaltic Andesites 0.3 

Andesites 0.35 

Dacites 0.4 

Tephrite 0.3 

Phono-Tephrite 0.35 

Tephri-Phonolite 0.4 

Trachybasalt 0.3 

Basaltic Trachyandesite 0.35 

Trachyandesite 0.4 

Rhyolites 0.5 

Phonolite 0.5 

Trachyte 0.5 

 

FE = Fe2O3 / 1.1113 + FeO: Fe2O3 = FE * FR * 1.1113:FeO = FE * (1 - FR) 

 

Where: 

FE = Total Fe 

FR = Fe Ratio 

 

If Adjust FeRatio is not selected, the CIPW Fe uses the Whole Rock Analysis Fe2O3 and FeO in wt% 

 

Metamorphic Indices Command 

 

   Totals the chemical analyses and calculates Eskola's Metamorphic Indices ACF and A'KF 
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1. ACF - the ratio Na O + K O/CaO/FeO+MgO+MnO 

 

Calculated as Follows: 

A=Al2O3+Fe2O3-(Na2O+K2O) 

C=CaO 

F=FeO+MgO+MnO 

 

1. A'KF - the ratio Na O + K O+CaO/K2O/FeO+MgO+MnO  

 

Calculated as Follows: 

A=Al2O3+Fe2O3-(Na2O+K2O+CaO) 

K=K2O 

F=FeO+MgO+MnO 

Options Menu 

 

   The File Menu provides many standard file management options. 

Set Classification Options Command 

 

   Opens the Classification Options Window for setting diagram options.  

Set Discrimination Options Command 

 

   Opens the Discrimination Options Window for setting diagram options. 

Set Log Options Command 

 

   Opens the Log Options Window for setting log-log and log-linear diagram options.  

Set Spider Options Command 

 

   Opens the Spider Plot Options Window for setting Spider Plot options.  

Set Ternary Options Command 

 

   Opens the Ternary/Diamond Options Window for setting diagram options.  
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Set XY Options Command 

 

   Opens the XY Options Window for setting XY diagram options.  

Define Columns Command 

 

   Defines which columns contain the XYZ data.  A Dialog box prompts the user for columns containing 

Sample #, Rockname, Symbol, Color, X Value, Y Value and Z Value.  When the default data file format is 

used, these correspond to columns 1, 2, 3, 4, 5, 6 and 7 respectively.  If a file using a different format is 

imported, new values can be entered.  For example, a file containing only XYZ data is imported.  X Value, 

Y Value and Z Value will be set to columns 1, 2 and 3 respectively.  In this example, Sample #, Symbol 

and Color can be left blank or assigned to empty columns. Whole Rock Chemistry use the predefined 

WinRock whole rock chemistry spreadsheet format for some diagrams requiring calculations. These 

diagrams are TAS-Volcanic, TAS-Plutonic, Tectonic Classification Diagrams and Spider Diagrams. 

Insert XY Headings 

 

   This command selects a general XY diagram and places the appropriate column headings in to the 

current spreadsheet.  Axes titles can be specified in the Options Window by selecting Set XY Options. 

Insert Ternary Headings 

 

   This command selects a general ternary diagram and places the appropriate column headings in to the 

current spreadsheet.  Axes titles can be specified in the Options Window by selecting Set Ternary 

Options. 

Insert Diamond Headings 

 

   This command selects a diamond diagram and places the appropriate column headings in to the 

current spreadsheet.  Axes titles can be specified in the Options Window by selecting Set Ternary 

Options. 

Format Command 

 

  Automatically formats numeric data in the spreadsheet.  Specify the number of decimal points and click 

on format to format data. 
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Statistics Command 

 

  Calculates the maximum, minimum, median, mean and standard deviation of a group of samples.  

Enter the spreadsheet column number containing the data to be analyzed.  Click on calculate to calculate 

statistics. 

Colors Command 

 

   Provides access to the Colors Dialog box for selecting the symbol colors.  Click on the color and click 

on insert to place the color code in the spreadsheet. 

Symbols Command 

 

   This command opens the Symbol window to view available symbols.  Click on the symbol and click on 

insert to place the symbol code number in the spreadsheet. 

Auto Symbols Command 

 

   Automatically assigns a symbol to each data point when a diagram is plotted. 

Assign Symbols Command 

 

Automatically calculates a different symbol for each data point and places the symbol codes into the 

spreadsheet under the Symbol column heading. 

 Convert to Coord Command 

 

   Converts modal mineralogy to XYZ coordinates as used by ternary diagrams. 

Tables Menu 

 

   Displays standard rock classification and petrographic tables in the spreadsheet.  The tables can be 

printed or displayed on screen.  They are useful to assist identifying groups of rocks and determining 

properties.  

 

Tables: 
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Conglomerates 

Dynamometamorphic 

Lamprophyres 

Limestones 

Meteorites 

Mudstones 

Phosphorites 

Pyroclastics 

Ultramafics 

Volcaniclastics 

 

Petrographic Charts 

Sedimentary grain size 

Igneous and metamorphic grainsize 

Roundness 

Volume 

Birefringence 

Plot Menu 

Classification Plot Command 

 

   Plots classification diagrams using data in the current spreadsheet.  The Classification Options Window 

pops up for selecting plotting options. 

Discrimination Plot Command 

 

   Plots discrimination graphs using data in the current spreadsheet.  The Discrimination Options Window 

pops up for selecting plotting options. 

Log Plot Command 

 

   Plots Log-Log and Log-Linear graphs using data in the current spreadsheet.  The Options Window 

pops up for selecting log plotting options. 

Spider Plot Command 
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   Plots spider diagrams using data in the current spreadsheet.  The Spider Plot Options Window pops up 

for selecting plotting options. 

Ternary Plot Command 

 

   Plots ternary and diamond graphs using data in the current spreadsheet.  The Options Window pops 

up for selecting plotting options. 

XY Plot Command 

 

   Plots XY graphs using data in the current spreadsheet.  The Options Window pops up for selecting XY 

plotting options. 
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The Spreadsheet 
 

Introduction 

 

   A spreadsheet is a form consisting of rows and columns of data and is the best method for displaying 

and manipulating data in row and column format.  The custom spreadsheet supplied with WinRock is 

used for entering and editing data.  Once the data is correctly entered, data can be sorted, calculated and 

plotted. 

File Formats  

    

   The built in spreadsheet saves data files in tab delimited ASCII format. This format is used by Microsoft 

Excel and is compatible with most spreadsheets. To import a data file created with another application, 

save the file in tab delimited format (in Excel, these files have a .txt extension), start WinRock and open 

the data file. WinRock will automatically load the file into the spreadsheet. To export a data file created 

with WinRock, use any of the following methods: 

 

1. Select tab delimited ASCII format in the other application. These files 

usually have a .txt extension. Open the file. 

2. In Excel, the file created with WinRock can simply be opened directly. 

 

In many applications, the file can simply be opened directly. 

 

   The built in spreadsheet requires data to be in a specific format for plotting and calculating. The first 

row in the spreadsheet is reserved for column headings. Any data placed in the first row will not be 

included in subsequent calculations. Imported data files will be displayed intact with all headings and 

data; however, to use WinRockôs features it is necessary to correctly define which columns contain 

sample #, symbol, color, Left, Right and Top values. As a minimum, WinRock requires Left, Right and 

Top values (XYZ) to work. Additional data can be entered via the keyboard or using the clipboard.  

    

   The spreadsheet can be slow to read large files. If this is the case, better performance can be obtained 

by deleting unused columns (setting columns to empty). For example, when performing a chemical 
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classification on a whole rock chemistry file, it is possible to delete all trace element columns (trace 

elements are not required in the calculation) before the operation to improve performance. 

    

   For geochemical data, each element is assigned to a specific column. For the calculations to work 

correctly, these columns must be used as is, in their pre-defined format. Do not change the whole rock 

geochemistry headings. 

 

The geochem columns are defined in the following format: 

Col1: Sample # 

Col2: Rockname 

Col3: Symbol 

Col4: Color 

Col5: SiO2 

Col6: TiO2 

Col7: Al2O3 

Col8: Fe2O3 

Col9: FeO 

Col10: MnO 

Col11: MgO 

Col12: CaO 

Col13: Na2O 

Col14: K2O 

Col15: P2O5 

Col16: H2O+ 

Col17: H2O- 

Co18: CO2 

Col19: CL 

Co20: F 

Col21: S 

Co22: SO3 

Col23: Cr2O3 

Co24: ZrO2 

Col25: Total 

Co26: LOI 

Col85: Silica Grade 

To End - Trace Elements 
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For multi element geochemistry, the columns have the following format: 

Col1: Sample # 

Col2: Rockname 

Col3: Symbol 

Col4: Color 

Col5: Au 

Col6: Ag 

Col7: As 

Col8: Cr 

Col9: Cu 

Col10: Fe 

Col11: Hg 

Col12: Mn 

Col13: Mo 

Col14: Ni 

Col15: Pb 

Col16: Pt 

Col17: Sb 

Co18: Sn 

Col19: Ti 

Co20: U 

Col21: V 

Co22: Zn 

Col23: Zr 

Col25: Total 

Co26: LOI 

Entering Data 

 

      Data is entered in each cell by simply typing the value and pressing <enter>.  Use the scroll bars, 

arrow, page up and page down keys to navigate through the spreadsheet.  Use the scroll bars when 

moving around the spreadsheet.  To edit a cell, press <enter> for the cell you want to edit and use the 

backspace/delete/insert keys to edit the text.  When finished editing press <enter> the new value will 

appear in the spreadsheet.  Whole rows can be inserted and deleted using the Insert Row and Delete 

Row toolbar buttons.  Blank lines are not permitted between data.   
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Sorting Data 

 

   To sort data, pull down the Edit menu and select Sort.  The Sort Menu allows the user to sort data in 

the spreadsheet.  A new window opens asking for the column number to sort.  Click on Sort to sort the 

spreadsheet. 

Converting Data to XYZ 

 

   If data has been entered as modal mineralogy, clicking on the convert to XYZ option in the Options 

Menu will convert the data to XYZ coordinates.  It is not necessary to convert data as conversion 

automatically takes place when a diagram is plotted. 

Printing Data 

 

   Pulling down the File menu and selecting Print prints data.  A Print Dialog box will pop up with several 

options.  Select OK to print the data.  A simple listing of current data will be printed. To print data in table 

format, select Print Spreadsheet. 

    

  

 

Hint: 

               Be sure the correct printer is selected as the default printer.  Use the options button 

in the Print Dialog box to select the correct printer. 
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The Diagrams 

 

Introduction 

 

WinRock will plot standard rock classification diagrams in addition to general-purpose xy, ternary, 

diamond, log-log and log-linear graphs.  Many options are available to customize the diagrams.  

Publication quality diagrams can be produced on a laser printer. 

 

Before plotting data, several options must be set to control the type and appearance of the diagram.  To 

access the Options window, pull down the Plot menu and select the diagrams to be plotted. 

Classification Plot Options Window 

 

   The Classification Options window has many user definable settings to control the diagram. For ternary 

plots (eg. QAP), data in the defined columns for top, left and right values are used. The default columns 

are columns 5, 6 and 7. For diamond plots (eg. QAPF), the defined column for the bottom apex is also 

used. The default column is column 8. For diamond plots, column 5 (top) and column 8 (bottom) data 

cannot be co-existing. Set column 5 (top apex) data to empty (zero) for each entry in column 8 (bottom 

apex). 

 

  Geochemical plots do not require user defined columns for plotting data. Geochemical data in the 

spreadsheet is already in a pre-defined format; therefore, when a diagram is selected, data for that 

diagram is obtained directly from the spreadsheet and the necessary calculations are performed 

automatically before plotting the diagram. 

Diagram Type 

 

   This option determines the type of diagram to be plotted.  Select from the list of diagram types. 

 

Plutonic Rocks 

Barker, 1979 ï An/Ab/Or, granites 

IUGS Carbonatites - CaO/MgO/FeO+Fe2O3+MnO carbonatites. Contains > 50% primary carbonates. 
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IUGS Charnockites - Quartz/Alkali Feldspar/Plagioclase charnockites. Contains >5% hypersthene 

IUGS Melilite Plutonic - Melilite/Olivine/Clinopyroxene melilite plutonic rocks. Contains > 10% melilite and 

<10% feldspathoids. 

IUGS General Plutonic QAPF - Quartz/Alkali Feldspar/Plagioclase/Foids plutonic rocks. Contains 0-90% 

mafic minerals. 

IUGS General Plutonic QAP - Quartz/Alkali Feldspar/Plagioclase plutonic rocks. Contains 0-90% mafic 

minerals. 

IUGS General Plutonic FAP - Foid/Alkali Feldspar/Plagioclase plutonic rocks. Contains 0-90% mafic 

minerals. 

Plutonic TAS - K2O+Na2O vs SiO2 chemical classification for plutonic rocks. Middlemost, 1994 

IUGS Mafic PlagPxOl - Plagioclase/Pyroxene/Olivine mafic rocks. Rocks falling into the gabbroic field of 

QAP diagram. 

IUGS Mafic PlagOpxCPx - Plagioclase/Orthopyroxene/Clinopyroxene mafic rocks. Rocks falling into the 

gabbroic field of QAP diagram. 

IUGS Mafic Plag/Px/Hbl - Plagioclase/Pyroxene/Hornblende mafic rocks. Rocks falling into the gabbroic 

field of QAP diagram. 

IUGS Ultramafic Ol/OPx/CPx - Olivine/Orthopyroxene/Clinopyroxene ultramafic rocks. Contains >90% 

mafic minerals. 

IUGS Ultramafic Ol/Px/Hbl - Olivine/Pyroxene/Hornblende ultramafic rocks. Contains >90% mafic 

minerals. 

 

Volcanic Rocks 

AFM Volcanic - K2O+Na2O/FeOt/MgO chemical classification for volcanic rocks. Irvin and Baragar, 1971 

IUGS Carbonatites - CaO/MgO/FeO+Fe2O3+MnO carbonatites. Contains > 50% primary carbonates. 

IUGS Melilite Volcanic - Melilite/Olivine/Clino-Pyroxene melilite volcanic rocks. Contains > 10% melilite 

and <10% feldspathoids. 

IUGS Volcanic QAPF - Quartz/Alkali Feldspar/Plagioclase/Foids volcanic rocks. Contains 0-90% mafic 

minerals. 

IUGS Volcanic QAP - Quartz/Alkali Feldspar/Plagioclase volcanic rocks. Contains 0-90% mafic minerals. 

IUGS Volcanic FAP - Foids/Alkali Feldspar/Plagioclase volcanic rocks. Contains 0-90% mafic minerals. 

IUGS Volcanic TAS - K2O+Na2O vs SiO2 chemical classification for volcanic rocks. Le Bas, 1986 

IUGS Volcanic TAS - K2O+Na2O vs SiO2 chemical classification for volcanic rocks. Middlemost, 1994 

Jensen Cation - Fet+Ti/Al/Mg chemical classification for volcanic rocks. Jensen, 1976, Modified by 

Rollinson, 1993 

Winchester and Floyd, 1977ï  Zr/TiO2 * 0.0001 vs SiO2, volcanic rocks 

Winchester and Floyd , 1977 ï Nb/Y vs Zr/TiO2 * 0.0001, volcanic rocks 

 

Sandstones 
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General Sandstones - Quartz/Clay/Feldspar general sandstones. Selley, 1984 

General Sandstones - Quartz/Feldspar/Rock Fragments general sandstones. Pettijohn, 1975 

Sandstones Arenites - Quartz/Feldspar/Rock Fragments for sandstones <15% clay. Pettijohn, 1975 

Sandstones Wackes - Quartz/Feldspar/Rock Fragments for sandstones >15% and <75% clay. Pettijohn, 

1975 

 

Metamorphic Rocks 

Metamorphic - ACF - the ratio Na O + K O/CaO/FeO+MgO+MnO 

Metamorphic - A'KF - the ratio Na O + K O+CaO/K2O/FeO+MgO+MnO  

 

Tectonic Classification Granites 

Batchelor and Bowden, 1985 - R1=4*Si-11*(Na + K)-2*(Fe + Ti) vs R2=6*Ca+2*Mg+Al in millications, 

granites 

Harris et al, 1986 ï Rb/10,Hf,Ta*3, granites 

Pearce et al, 1984 - Y+Nb vs Rb, granites 

Pearce et al, 1984 - Y vs Nb, granites 

Pearce et al, 1984 - Ta+Yb vs Rb, granites  

Pearce et al, 1984 - Yb vs Ta, granites 

 

Tectonic Classification Basalts 

Pearce and Cann, 1973 - Zr vs Ti , basalts 

Pearce and Cann, 1973 - Ti/100,Zr,Y*3, basalts 

Pearce et al., 1977 - FeT, MgO, Al2O3, for rocks with SiO2 greater than 51 percent and less than 56 

percent,  basalts 

Meschede, 1986 ï 2*Nb,Zr/4,Y, basalts 

Mullen, 1983 - TiO2, 10xMnO 10xP2O5, with SiO2 greater than 45 percent and less than 54 percent, 

basalts 

Set Labels 

 

   This option determines which labels appear on the diagram.  Select from: 

 

 1.none - no labels appear on the diagram 

 

 2.sample # - sample #'s as shown on the spreadsheet 

 

Labels will be printed with the diagram. 
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Axes 

 

 Specify your own axes titles here. 

Symbol Definitions 

 

   If you want symbol descriptions printed with the diagram, enter the descriptions here. 

 

Discrimination Plot Options Window 

 

   The Discrimination Plot Options Window sets options for Discrimination plots. Discrimination plots use 

data from the spreadsheet in the Winrock geochemical data format. Do not change columns for the 

whole rock or trace element data. 

Graph and Scale Type 

 

   Select standard XY Plot or XY Line Plot to plot points connected by lines.  Auto Scale or Manual Scale 

can be selected. 

Set Scale 

 

   When Manual Scale is selected enter maximum and minimum values for the X and Y axes here. 

Set Titles 

 

   Enter diagram, x-axis and y-axis titles here. 

 

X and Y Axes 

 

   Sets the X and Y Axes for Discrimination Plots. Uses data in the current spreadsheet. Data must be in 

the pre-defined format for whole chemistry and multi-element chemistry. Load one of the sample whole 

rock chemistry data files or select Insert Whole Rock Headings from the Geochem Menu to view the pre-

defined format. Select the elements from the pre-defined lists for X and Y Axes. For example, if SiO2 is 

selected as X Axes and K2O is selected as Y Axes, the graph will be plotted as a SiO2 vs K2O plot. 
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Log Plot Options Window 

 

The Log Plot Options Window sets options for Log-Log and Log-Linear Plots. For log plots, data in the 

defined columns for x and y values are used. The default columns are columns 5, and 6. These columns 

can be changed, if necessary, using the Define Columns command. 

Cycles 

 

   Select the number of cycles required to plot on the log graph.  Upto 4 cycles can be plotted on the X 

and Y axes. 

Scale 

 

   Select the scale of the X and Y axes here. 

Scale Type 

 

   Select log-log or log-linear type plots 

Titles 

 

   Enter titles for the graph and x and y axes here. 

Spider Plot Options Window 

 

   The Spider Plot Options Window initializes the settings for Spider Plots. Spider plots use data from the 

spreadsheet in the Winrock geochemical data format. Do not change columns for the whole rock or trace 

element data. 

Normalize 

 

   Select the type of normalization to be applied to the trace element chemistry. For example, select 

MORB to apply the MORB norm of Pearce (1983). 

 

Norms Available: 
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MORB Pearce (1983) 

Sr,K,Rb,Ba,Th,Ta,Nb,Ce,P,Zr,Hf,Sm,Ti,Y,Yb 

 

REE Chondrite Boyden (1984) 

La,Ce,Pr,Nd,Pm,Sm,Eu,Gd,Tb,Dy,Ho,Er,Tm,Yb,Lu  

 

ORG (Pearce et al.1984)  

K2O,Rb,Ba,Th,Ta,Nb,Ce,Hf,Zr,Sm,Y,Yb 

 

Primitive Mantle (Sun & McDonough 1989) 

Cs,Rb,Ba,Th,U,Nb,K,La,Ce,Pb,Pr,Sr,P,Nd,Zr,Sm,Eu,Ti,Dy,Y,Yb,Lu  

 

Additional norms are available in norm definition files in the winrock\spider folder. 

Select Elements 

 

   Select elements to plot on the Spider Diagram from the list of elements. Multiple selections can be 

made. When a norm is selected, the elements are automatically assigned and no selection is necessary. 

Use File Norm 

 

   A norm definition file can be used to plot spider diagrams. You can create your own definition file or use 

one of the supplied files. The supplied definition files are in the winrock\spider folder. Norm definition files 

can be opened and edited within WinRock. They should be saved as plain text files (tab delim ASCII, 

csv) or WinRock (*.rok) files. Norm definition files are plain text files in the following format: 

 

Title 

Element1 

Value1 

Element2 

Value2 

Element3 

Value3 

etc. to End 

 

   The first line is reserved for a title. The second line contains the first element in the norm. The third line 

contains the normalization factor for that element. This elements continue to the end of the file. 

for example: 
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Spider Plot Norm MORB 

Rb 

2.0 

Sr 

120 

Ba 

20 

etc. to End 

 

   If a norm definition file is plotted, specify the correct scale to plot the Spider diagram correctly. 

Scale 

 

   Spider diagrams use log scales on the y-axis because of the large range of values in trace elements. 

You can select the scale here. Select from 2 cycle, 3 cycle, 4 cycle, 5 cycle or 6 cycle log scales. When a 

norm is selected, the scale is automatically assigned and no selection is necessary. 

 

Symbols 

 

   If you want symbol descriptions printed with the diagram, enter the descriptions here. 

Titles 

 

   Enter the titles to appear on the diagram 

Ternary Plot Options Window 

 

   The Ternary/Diamond Options window has many user definable settings to control the diagram. For 

ternary plots, data in the defined columns for top, left and right values are used. The default columns are 

columns 5, 6 and 7. For diamond plots, the defined column for the bottom apex is also used. The default 

column is column 8. For diamond plots, column 5 (top) and column 8 (bottom) data cannot be co-

existing. Set column 5 (top apex) data to empty (zero) for each entry in column 8 (bottom apex). 

Axes Titles 
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   Specify the axes titles for plots here. 

Diagram Type 

 

   This option determines the type of diagram to be plotted.  Select from the list of diagram types.  

Set Labels 

 

   This option determines which labels appear on the diagram.  Select from: 

 

 1.none - no labels appear on the diagram 

 

 2.sample # - sample #'s as shown on the spreadsheet 

 

Labels will be printed with the diagram. 

Symbol Definitions 

 

   If you want symbol descriptions printed with the diagram, enter the descriptions here. 

XY Plot Options Window 

 

   The XY Setup Window sets options for XY plots. For XY plots, data in the defined columns for x and y 

values are used. The default columns are columns 5, and 6. These columns can be changed, if 

necessary, using the Define Columns command.  

Graph and Scale Type 

 

   Select standard XY Plot or XY Line Plot to plot points connected by lines.  Auto Scale or Manual Scale 

can be selected. 

Set Scale 

 

   When Manual Scale is selected enter maximum and minimum values for the X and Y axes here. 

Set Titles 
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   Enter diagram, x-axis and y-axis titles here. 

Plot Window 

 

   The Plot window displays the diagram and sends output to the printer or disk.  The Plot window 

contains a menu bar, a diagram area, grid list, labels box and toolbar.  The diagram is data sensitive so 

that each highlighted data point corresponds to a highlighted set of data within the grid.  Diagrams can be 

saved as bitmap (.bmp) graphic files for exporting to other applications. 

Axes Color 

 

   To change the default color of the diagram, select this command.  A Colors Dialog box will pop up.  

Select a color and click OK. 

Box Draw 

 

   To draw a box, select box draw.  The cursor will change to a cross hair.  Position the cross hair where 

the box is to begin and drag the cursor by holding down the left mouse button.  A dotted box is dragged 

with the mouse.  Release the left mouse button when you have positioned the box correctly. 

Copy Diagram Command 

 

   Copies the current diagram to the clipboard for pasting into other applications. 

Data Grid 

 

   Displays a list of data values that appear on the diagram.  The data point represented by the selected 

text in the grid is be highlighted.  If the Labels Box is empty press <enter> in the grid to display the 

sample # next to the highlighted data point.  

Delete All 

 

  Deletes all drawing and text actions and redraws the plot 

Fields 

 

   If this command is checked, all fields and field labels are displayed and printed with the diagram. 
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Field Labels 

 

   This option determines whether field labels are displayed on screen and printed with the diagram.  

When Field Labels is checked all field labels are displayed and printed with the diagram. 

Fonts 

 

   To change the font for inserted text select Fonts.  A Font Dialog box is displayed with a list of available 

fonts.  Select a font in the list. 

Insert Text 

 

   To insert text select Insert Text.  The cursor will change to an insertion icon.  Position the cursor where 

you would like to insert text and click the left mouse button.  Type the text to be inserted. 

Labels  

 

   Enter some text in the box to plot as a label.   To display a label, enter a label and click a row in the grid. 

 Double click a row in the grid to display the label for the highlighted row.  Repeat the procedure to display 

labels for other points.  When Print Diagram is selected, labels will be printed with the diagram. 

Line Draw 

 

   To draw a line select Line Draw.  The cursor will change to a cross hair.  Position the cursor where you 

would like the line to begin and drag the line by holding down the left mouse button and moving the 

mouse.  Release the left mouse button when the line is positioned correctly. 

Print Bitmap 

 

   Prints the current diagram as a bitmap.  A pop up Print dialog box appears.  Click Options to access the 

Print Setup dialog box.  Click OK to accept the default settings and print the diagram.  Bitmaps print as 

the picture is displayed on screen, what you see is what you get (WYSIWYG). The resolution of the 

screen bitmaps is generally not as high as vector resolution (Print Diagram), but there is less 

complication with formatting of fonts and symbols. The size of the printed bitmap can be selected using 

the Diagram Size Option in the Option Menu. Select from small, medium or large. Similar prints may be 

obtained using the Print Screen button on your keyboard (Press Alt and Prnt Scrn) to capture the window 

and printing the screen capture. 
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Print Diagram 

 

   Prints the current diagram.  A pop up Print Dialog box appears.  Click Options to access the Print Setup 

Dialog box.  Click OK to accept the default settings and print the diagram.  Labels are printed with the 

Diagram.  If  Field Labels and Symbol Legends are enabled in the Options Menu, these will be printed. 

Rocknames Table 

 

   This contains the field definitions and rocknames for the current classification diagram. 

Save Diagram As Command 

 

   This command saves the current diagram in a user-specified directory and filename.  A pop up Dialog 

box appears which prompts the user for directory path and filename information.  Diagrams can be saved 

in bitmap (.bmp) format for exporting into a painting program for further editing. 

Symbol Legend  

 

   Select Symbol Legend (Display) to display a symbol legend on screen.  

To add symbol descriptions, type the description next to the desired symbol. Symbol descriptions can be 

printed with the graph by enabling one of the symbol legends in the Symbol Legend (Print) option of the 

Options Menu. The sample # and rockname legends use the values entered into the spreadsheet under 

the corresponding headings.  Symbol Legends printed with the diagram are formatted to print correctly on 

A4/Letter size paper. Different results may be obtained on other paper sizes. 

Tick Marks 

 

   If this command is checked, tick marks are displayed and printed with the diagram. 

Undo 

 

  To use Undo, first select the drawing action to undo then click on the undo button or the undo menu 

command. 

Zoom 
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   To magnify all or part of the plot click on the zoom toolbar button.  Drag the mouse over the portion of 

the plot to magnify.  A new window will display the magnified image.
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Geolbases 
 

 Geolbases is a set of geological databases to help retrieval of mineralogical and petrological data.  Each 

database has its own unique graphical user interface so they can be used individually without having to 

change tables and report layouts.  A database manager allows access to each database from Windows 

or the databases can be accessed from the database menu in WinRock. 

GeolBases Features 

Microsoft Access Jet Database Engine 

 

   Each database uses the 32 bit Microsoft Jet Database Engine.  

Querying 

 

   The databases use standard SQL query language to search records, however the SQL language is 

hidden behind a simplified Search interface so that no previous knowledge of SQL is required.  The 

search engine keyword and substring searches are based on whatever text is input by the user. 

Printing and Clipboard Support 

 

   Each database has printing and clipboard support.  Search results can be printed in tables and 

information from the databases and be copied to the clipboard for use in other applications. 

Getting Started 

 

   Geolbases requires a minimum system configuration.  The system requirements are: 

 

  Windows 2000 , XP , Vista, Windows 7, Server 2008 

 Internet Explorer 6 SP1   

 800x600 Display Resolution 

  Mouse 

  Printer supported by Windows 
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 For automatic installation, proceed as follows: 

 

 1. Start Windows 

 2. Select My Computer  

 3. Open (CDDrive)D:\Geolbases\Disk1\setup.exe to start Setup 

The WinRock Database 

 

   The WinRock Database for Windows is a petrographic database of igneous, metamorphic and 

sedimentary rocks.   Each rocktype contains a petrographic summary consisting of Rock Name, Group, 

Family, Texture, Structure, Composition, Occurrence and Comments.  The descriptions have been 

standardized using the usual petrographic terms.  Searches can be carried out on individual or multiple 

fields using partial or complete key words.  The composition field can be searched with up to three 

minerals simultaneously. 

Using The WinRock Database 

 

   Click on The WinRock Database menu item or icon to start the program.  The WinRock Database 

Window is displayed with a scrollable list of rock names and their descriptions.  Records can be printed 

or copied to the clipboard. 

 

   To start a query click on the Query command button.  The Search Window is displayed with a list of 

searchable fields.  Enter search terms in the appropriate fields.     The database has been standardized 

using the usual petrographic terms.  These terms are listed under the appropriate fields in the Search 

Window.  It is recommended that searches are made using these terms; however, descriptions are not 

limited to these terms and any keyword can be used.  Click on Search to start a search.  A list of matches 

is displayed in The WinRock Database Window.  Search results can be printed or copied to the 

clipboard. To list the entire database click on the Refresh command button. 

 

   The WinRock Database is editable.  Enable editing by selecting Edit Database, then Enable.  Once the 

edit mode is enabled, any changes made to the database will automatically be saved. Selecting Add New 

Record can enter a new record.  A new record with empty fields is created. 

 

Important: Blank and null entries are not allowed in the database. If no entry is desired under a specific 

property then enter "Empty" for that specific property. Default values for all properties are "Empty".  This 

word is automatically added to new entries. 
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   Bookmarks can be entered using the database ID property. Enable editing and enter a unique 

number/label into the ID field. This label is searchable with the Query/Search option. Useful for indexing 

samples or as simple reference bookmarks. 

 

    A set of sample images is included with the database.  Further images can be added by selecting Add 

Image from the File Menu in Image Viewer Window. Images can be copied and pasted from the 

clipboard. Select Add Image to add an image.  Close Image Viewer Window to save the image to the 

database. 

 

   There are three customizable project databases available for use. All functions work on these 

databases in the same way as for the Main Database. To select a project database goto Active Database 

on the Edit Menu and select a database. 

List of Search Terms 

Group 

Igneous 

Metamorphic 

Sedimentary 

Structure 

Massive - No structure 

Foliated - Planar alignment of platy minerals 

Schistose - Discontinuous planar alignment of minerals 

Flow - Changing alignment of minerals in a flow pattern 

Banded - With bands of different composition or color 

Bedded/Laminated - Divided into separate layers     

Texture 

Crystalline - All crystalline textures, with a grain size > 0.2mm (e.g. Granite, Gneiss) 

Microcrystalline - Crystalline textures with a grain size < 0.2mm and > 0.01mm (e.g. Hornfels) 

Cryptocrystalline - Crystalline textures with a grain size < 0.01mm (e.g. Agate) 

Amorphous - Non crystalline, glassy (e.g. Obsidian) 

Porphyritic - Large crystals (phenocrysts) in a fine-grained ground mass (e.g. Basalt) 

Recrystallized - Textures produced by partial recrystallization (e.g. Meta-Basalt) 

Inequigranular - Fine to macro - sized grains  (e.g. Kimberlite)  

Fragmental - Composed of mineral and/or rock fragments (e.g. pyroclastics) 
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Biogenic- Textures produced by organisms (e.g. Limestone - Boundstone) 

Organic-Textures produced by organic material (e.g. coal) 

Clastic - Textures produced by mechanically accumulated grains cemented together (e.g. Sandstone) 

Chemical - Textures produced by chemical precipitation (e.g. Anhydrite) 

Occurrence 

Plutonic - A general term for any large scale intrusive rocks 

Volcanic - Extrusive and associated intrusive rocks 

Regional Metamorphic - Metamorphic rocks occurring over large areas 

Contact Metamorphic - Adjacent to intrusions 

Fault/Shear Zone - Planar zones of brittle and/or ductile deformation 

Basin - Sedimentary rocks in a sedimentary basin. 
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MinServ Mineral Database 

 

  The MinServ Mineral Database is a reference database of over 3700 minerals.  Mineral Name, Formula 

and Crystal System index each mineral.  Nearly all registered mineral names are listed but group terms 

such as feldspar and apatite are not listed.  The database can be searched for key words and substrings 

and the results printed and copied to the clipboard. 

Using The Mineral Database 

 

    The Mineral Database has all entries listed in a table.  Minerals can be scrolled up and down through 

the table. To find a specific property, it is a simple matter of entering a search term and selecting the field 

to be searched to find a specific mineral.  The results can be printed or copied to the clipboard for use 

with other applications. 

 

   The Mineral Database is editable.  Enable editing by selecting Edit Database, then Enable. Once the 

edit mode is enabled, any changes made to the database should be saved by using the Save Command 

or clicking on the Refresh Button.  Selecting Add New Record can enter a new record.  A new record with 

empty fields is created. 

 

Important: Blank and null entries are not allowed in the database. If no entry is desired under a specific 

property then enter "Empty" for that specific property. Default values for all properties are "Empty".  This 

word is automatically added to new entries. 

 

   Bookmarks can be entered using the database ID property. Enable editing and enter a unique 

number/label into the ID field. This label is searchable with the Query/Search option. Useful for indexing 

samples or as simple reference bookmarks. 

 

There are three customizable project databases available for use. All functions work on these databases 

in the same way as for the Main Database. To select a project database goto Active Database on the 

Edit Menu and select a database. 

 

Mineral Properties Included 

 

Mineral Name - The International Mineralogical Organization recognized mineral name 

 

Formula - Enter part or whole formula i.e. Cu for formula containing copper 
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Crystal System - Enter crystal system 

Isometric or cubic 

Hexagonal or trigonal 

Tetragonal 

Orthorhombic 

Monoclinic 

Triclinic 
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MinServ Rock Forming Minerals Database 

 

  The MinServ Rock Forming Minerals Database is a reference database of all rock forming and 

accessory minerals.  The database is divided into two sections: 1. Physical properties, listing all physical 

properties and 2. Optical properties, listing all optical properties visible with a polarizing microscope.   

Using The Database 

 

    The Rock Forming Minerals Database is based around a standard mineral description report displayed 

as a form with a scrollable list of mineral names linked to each mineral property.  Properties for each 

mineral are displayed as the names are selected from a scrollable list. Clicking on the Query button can 

search all properties. It is a simple matter of entering a search term and selecting the field to be searched 

to find a specific mineral.  The results can be printed or copied to the clipboard for use with other 

applications. 

 

   The Rock Forming Minerals Database is editable.  Enable editing by selecting Edit Optical Database, 

then Enable.  Once the edit mode is enabled, any changes made to the database will automatically be 

saved. Selecting Add New Record can enter a new record.  A new record with empty fields is created. 

 

Important: Blank and null entries are not allowed in the database. If no entry is desired under a specific 

property then enter "Empty" for that specific property. Default values for all properties are "Empty".  This 

word is automatically added to new entries. 

 

   Bookmarks can be entered using the database ID property. Enable editing and enter a unique 

number/label into the ID field. This label is searchable with the Query/Search option. Useful for indexing 

samples or as simple reference bookmarks. 

 

   A set of sample images is included with the database.  Further images can be added by selecting Add 

Image from the File Menu in Image Viewer Window. Images can be copied and pasted from the 

clipboard. The image can also be added within Image Viewer using the menu.  Close Image Viewer 

Window to save the image to the database. 

 

   There are three customizable project databases available for use. All functions work on these 

databases in the same way as for the Main Database. To select a project database goto Active Database 

on the Edit Menu and select a database. 
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Recommended Search Terms: 

 

Formula - Enter part or whole formula i.e. Cu for formula containing copper 

 

Crystal System - Enter crystal system 

Isometric or cubic 

Hexagonal or trigonal 

Tetragonal 

Orthorhombic 

Monoclinic 

Triclinic 

 

Group - Enter mineral group name 

Quartz 

Pyroxene 

Feldspar 

Garnet 

Serpentine 

Clay 

Mica 

Brittle Mica 

Bauxite 

Oxide 

Amphibole 

Feldspathoid 

Zeolite 

Silliminite 

Calcite 

Barite 

Humite 

Tourmaline 

Epidote 

Chlorite 

 

Specific Gravity - the relative weight of a mineral as compared to water 

 

Hardness - hardness of a mineral according to Moh's Hardness Scale 
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1 - Soft, i.e. Talc 

2 - Copper 

3 - Calcite 

4 - Fluorite 

5 - Medium i.e. Apatite 

6 - Feldspar 

7 - Glass or Quartz 

8 - Topaz 

9 - Corundum 

10 - Hardest natural occurring mineral, Diamond 

 

Streak - Color of a minerals powder when crushed. Determined by rubbing a mineral on a porcelain plate. 

White - most common, feldspar, calcite, garnet 

Black - magnetite, uraninite 

Green - hornblende, vesuvianite 

 

Color - Natural color of a mineral 

Black - Mica, Uraninite, Hematite 

White - Plagioclase 

Pink - Orthoclase 

Green - Chlorite, Olivine 

 

Opacity - The transparency of a mineral 

Opaque - Does not transmit light 

Translucent - Partially transmits light 

Transparent - Fully transmits light 

 

Luster - Appearance of a minerals surface 

Pearly - Smooth, shiny, white surface, talc, calcite 

Vitreous - Glass like, most transparent minerals are vitreous, quartz, garnet 

Dull - Does not shine, talc, kaolinite 

Adamantine - Brilliant shining surface, diamond 

Soapy - Soapy feel, talc, chlorite 

Greasy - Greasy feel, topaz, olivine 

Silky - Like silk, antigorite, anthophyllite 

Waxy - Wax like surface, quartz, serpentine,  

Satin - Satin like surface, kaolinite 

Submetallic - Shiny, opaque, metallic like surface, mica 
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Metallic - Shiny, metallic surface, pyrite 

Splintery - In splinters, chlorite 

 

Habit - A minerals external form 

Cubic - In cubes, pyrite, halite garnet 

Polyhedrons/Octohedrons - Garnet, fluorite 

Rhombohedral - Rhomb shaped, calcite, chiastolite 

Prismatic - Rectangular, square outlines, very common, hornblende, epidote, augite, zircon, sphene 

Hexagonal - Hexagonal or triangular outlines, tourmaline, beryl, topaz 

Tabular - Thick, flat prismatic outlines, feldspar, biotite, chlorite, epidote, olivine 

Columnar - Thin columns, often in aggregates, tourmaline, actinolite/tremolite, hornblende, diopside 

Flakes/Plates/Scales - Mostly the fine, microcrystalline varieties. Mica, clay minerals, chlorite, sericite 

Fibrous - In fibers, actinolite/tremolite, talc, serpentine, nephrite 

Acicular - Fine, needle like crystals, tourmaline, rutile, mimetite (apatite) 

Radiating - Outwardly radiating from a center, zeolite, tourmaline, gypsum 

Spherulitic - A radiating acicular mass of crystals forming a circular shaped pattern. Common pattern in 

devitrified volcanic glass 

Short - Short 

Long - Long 

 

Occurrence - The mode of occurrence and/or formation of a mineral 

Veins - hydrothermal veins, quartz, calcite veins 

Pegmatites - V.coarse grained veins of granites, feldspars, tourmaline, micas 

Vesicular/Amygdaloidal - Cavities in volcanic rocks 

Evaporites - Within sedimentary evaporite basins 

Metamorphic (Contact) - Along contact zones of recrystallized rocks, hornfels, skarn 

Metamorphic (Regional) - Metamorphic rocks occurring over a large area, gneiss 

Igneous - Generally some form of magmatic intrusion, granite, gabbro 

Sedimentary - Derived from pre-existing rocks and often laid down in layers, sandstone, shale 

Sedimentary Limestones - Deposited in ocean basins due reef building or accumulation of carbonate 

grains (detrital or precipitation), limestone 

 

Optical Mineralogy Database 

Most of these properties are only discernable with a polarizing microscope, as used by geologists. 

 

Relief - The visibility of a mineral in plane polarized light. Usually compared to adjacent minerals or the 

cementing material used in the slide, such as balsam. 
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Birefringence - The interference color observable under crossed polars. Refer to a birefringence table to 

determine values 

 

2V - The angle of the optical axis in biaxial minerals. Measured in an oriented crystal with a Bertrand 

Lens under crossed polars and high power. 

 

Optical Sign - Most minerals are either uniaxial, with a single optic axis or biaxial, with two optic axes i.e. 

quartz, calcite, tourmaline are uniaxial, olivine, augite, hornblende, feldspar are biaxial.  

 

Refractive Index - The degree to which a crystal bends light, as it passes through a crystal. The RI varies 

according to the optical axes. Uniaxial minerals have two directions of RI: 1. Along the ordinary ray; and 

2. Along the extraordinary ray.. Biaxial minerals have three directions of RI: 1. Nalpha, 2. Nbeta and 3. 

Ngamma. 

 

Pleochroism - The variation in color as a mineral is rotated under plane polarized light. I.e. hornblende, 

biotite are strongly pleochroic 

 

Extinction Angle - The type of extinction when a mineral is rotated under crossed polarized light. 

Parallel - Parallel to cleavage or crystal outlines 

Oblique - At an angle to cleavage or crystal outlines 

Symmetrical - Symmetrical to crystal shape or cleavage, i.e. hornblende, hypersthene, dolomite 

 

Cleavage - Cleavage outlines in thin section are often distinctive of a mineral. 

Amphibole Cleavage - Two at 56" and 124" in cross section 

Pyroxene Cleavage - Two at 83" and 97" in cross section 

Mica Cleavage - Perfect in one direction 

Chlorite Cleavage - Perfect in one direction 

Cubic Cleavage - Halite, galena 

Cleavage/Foliation Masses/Aggregates - Aggregates of planar minerals, such as chlorite and mica in one 

direction, parallel to cleavage. 

 

Twinning - Twinned crystals are often observed in thin section and are distinctive of certain minerals 

Polysynthetic Twinning Albite Law - Plagioclase feldspars almost always exhibit this. Used to determine 

Albite/Anorthite content 

Simple Twinning, Amphibole - Hornblende often is twinned with two crystals sharing a common twin 

plane 

Simple Twinning, Carlsbad - Very common in K-feldspars 
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Penetration Twinning - Where two crystals penetrate each other through the center, andalusite, staurolite, 

cordierite 
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MinServ Economic Database 

 

   The MinServ Commodity Database contains data on economic minerals and their uses.  It has over 70 

commodities and 200 economic minerals covering all major ore and industrial mineral commodities.   

Using The Commodity Database 

 

   The Commodity Database has all entries indexed by commodity and displayed report style.  Each 

mineral is listed in a scrollable table and linked to their respective physical properties.  As a mineral is 

selected in the list, all physical properties for that mineral are displayed on the report form. A separate 

query form allows querying of all fields by keyword or substring.  To perform a query, click on query and 

enter the search terms under the field to be searched.  Leave fields not searched blank.  Click on Search 

to perform the Search.  A list of matches is shown in the main window.  Scroll through the minerals to see 

each record that matches the query. 

 

   The Commodities Database is editable.  Enable editing by selecting Edit Database, then Enable.  Once 

the edit mode is enabled, any changes made to the database will automatically be saved. A new record 

can be entered by selecting Add New Record.  A new record with empty fields is created. 

 

Important: Blank and null entries are not allowed in the database. If no entry is desired under a specific 

property then enter "Empty" for that specific property. Default values for all properties are "Empty".  This 

word is automatically added to new entries. 

 

   Bookmarks can be entered using the database ID property. Enable editing and enter a unique 

number/label into the ID field. This label is searchable with the Query/Search option. Useful for indexing 

samples or as simple reference bookmarks. 

   

   A set of sample images is included with the database.  Further images can be added by selecting Add 

Image from the File Menu in Image Viewer Window. Images can be copied and pasted from the 

clipboard. The image can also be edited within Image Viewer using the menu.  Close Image Viewer 

Window to save the image to the database. 

 

   There are three customizable project databases available for use. All functions work on these 

databases in the same way as for the Main Database. To select a project database goto Active Database 

on the Edit Menu and select a database. 
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Recommended Search Terms: 

 

Commodity - Enter a commodity 

Aluminum 

Feldspar 

Garnet 

Lithium 

Uranium 

Copper 

Lead 

Zinc 

Nickel 

Iron 

Phosphate 

Gold 

Silver 

Etc. 

 

Formula - Enter part or whole formula i.e. Cu for formula containing copper 

 

Crystal System - Enter crystal system 

Isometric or cubic 

Hexagonal or trigonal 

Tetragonal 

Orthorhombic 

Monoclinic 

Triclinic 

 

Group - Enter mineral group name 

Quartz 

Pyroxene 

Feldspar 

Garnet 

Serpentine 

Clay 

Mica 

Brittle Mica 
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Bauxite 

Oxide 

Amphibole 

Feldspathoid 

Zeolite 

Silliminite 

Calcite 

Barite 

Humite 

Tourmaline 

Epidote 

Chlorite 

 

Specific Gravity - the relative weight of a mineral as compared to water 

 

Hardness - hardness of a mineral according to Moh's Hardness Scale 

 

1 - Soft, i.e. Talc 

2 - Copper 

3 - Calcite 

4 - Fluorite 

5 - Medium i.e. Apatite 

6 - Feldspar 

7 - Glass or Quartz 

8 - Topaz 

9 - Corundum 

10 - Hardest natural occurring mineral, Diamond 

 

Streak - Color of a minerals powder when crushed. Determined by rubbing a mineral on a porcelain plate. 

White - most common, feldspar, calcite, garnet 

Black - magnetite, uraninite 

Green - hornblende, vesuvianite 

 

Color - Natural color of a mineral 

Black - Mica, Uraninite, Hematite 

White - Plagioclase 

Pink - Orthoclase 

Green - Chlorite, Olivine 
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Opacity - The transparency of a mineral 

Opaque - Does not transmit light 

Translucent - Partially transmits light 

Transparent - Fully transmits light 

 

Luster - Appearance of a minerals surface 

Pearly - Smooth, shiny, white surface, talc, calcite 

Vitreous - Glass like, most transparent minerals are vitreous, quartz, garnet 

Dull - Does not shine, talc, kaolinite 

Adamantine - Brilliant shining surface, diamond 

Soapy - Soapy feel, talc, chlorite 

Greasy - Greasy feel, topaz, olivine 

Silky - Like silk, antigorite, anthophyllite 

Waxy - Wax like surface, quartz, serpentine,  

Satin - Satin like surface, kaolinite 

Submetallic - Shiny, opaque, metallic like surface, mica 

Metallic - Shiny, metallic surface, pyrite 

Splintery - In splinters, chlorite 

 

Habit - A minerals external form 

Cubic  In cubes, pyrite, halite garnet 

Polyhedrons/Octohedrons - Garnet, fluorite 

Rhombohedral - Rhomb shaped, calcite, chiastolite 

Prismatic - Rectangular, square outlines, very common, hornblende, epidote, augite, zircon, sphene 

Hexagonal - Hexagonal or triangular outlines, tourmaline, beryl, topaz 

Tabular - Thick, flat prismatic outlines, feldspar, biotite, chlorite, epidote, olivine 

Columnar - Thin columns, often in aggregates, tourmaline, actinolite/tremolite, hornblende, diopside 

Flakes/Plates/Scales - Mostly the fine, microcrystalline varieties. Mica, clay minerals, chlorite, sericite 

Fibrous - In fibers, actinolite/tremolite, talc, serpentine, nephrite 

Acicular - Fine, needle like crystals, tourmaline, rutile, mimetite (apatite) 

Radiating - Outwardly radiating from a center, zeolite, tourmaline, gypsum 

Spherulitic - A radiating acicular mass of crystals forming a circular shaped pattern. Common pattern in 

devitrified volcanic glass 

Short - Short 

Long - Long 

 

Uses - The main uses for and applications for this commodity 
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Lithium - Greases, ceramics, production of aluminum 

Garnet - Abrasives 

Feldspar - Manufacture of porcelain 

Lead - Pipes, batteries, radiation shielding 

Copper - Alloyed for bronzes, brasses, electrical 

Nickel - Steel making 

 

Model - The mode of occurrence and/or formation of an economic mineral 

Veins - hydrothermal veins, quartz, calcite veins 

Pegmatites - V.coarse grained veins of granites, feldspars, tourmaline, micas 

Vesicular/Amygdaloidal - Cavities in volcanic rocks 

Evaporites - Within sedimentary evaporite basins 

Metamorphic (Contact) - Along contact zones of recrystallized rocks, hornfels, skarn 

Metamorphic (Regional) - Metamorphic rocks occurring over a large area, gneiss 

Igneous - Generally some form of magmatic intrusion, granite, gabbro 

Sedimentary - Derived from pre-existing rocks and often laid down in layers, sandstone, shale 

Sedimentary Limestones - Deposited in ocean basins due reef building or accumulation of carbonate 

grains (detrital or precipitation), limestone 

Replacement - Hydrothermal replacement deposits 
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MinServ XRD Minerals Database 

 

The MinServ XRD Minerals Database contains XRD data on all minerals.  Over 3800 minerals with 

mineral name and three strongest d-spacings are listed. 

Using The XRD Database 

 
   The XRD Database has all entries indexed by mineral name and d-spacing and is displayed in tabular 

format.  The table can be browsed using scroll bars. To perform a query, enter the search terms in the 

search option boxes.  Mineral name and d-spacing can be searched and d-spacing search limits can be 

entered or selected.   

 

Important: Search limits must be entered for d-spacing searches.  In most cases, a narrow search 

pattern will give the most accurate results. If the XRD peaks are uncertain, perform a wider search, by 

specifying a wider d-spacing range. 

 

   Click on Search to perform the search.  A list of matches is shown in the main window.  Scroll through 

the minerals to see each record that matches the query.  The results may be printed.  The database can 

be sorted according to mineral name or d-spacing  from the Edit Menu and all data can be printed. 

 

   This database is editable. Enable editing by selecting Edit Database, then Enable.  Once the edit mode 

is enabled, any changes made to the database should be saved by using the Save Command or clicking 

on the Refresh Button. A new record can be entered by selecting Add New Record.  A new record with 

empty fields is created. 

 

Important: Blank and null entries are not allowed in the database. If no entry is desired under a specific 

property then enter "Empty" for that specific property. Default values for all properties are "Empty".  This 

word is automatically added to new entries. 

 

   There are three customizable project databases available for use. All functions work on these 

databases in the same way as for the Main Database. To select a project database goto Active Database 

on the Edit Menu and select a database. 
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Backing Up Databases 

 

   The Mineral Databases are editable. Any changes to the databases are saved to the database; 

however, it is highly recommended, the databases are backed up periodically. The easiest way to do this 

is to copy the database files, *.mdb, to a backup folder of your choice using Windows Explorer or My 

Computer File Manager. 
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Software Support 
   
 
    Technical support for WinRock is provided through the printed manual and online help.  Quick help is 

obtained by pressing F1 to access online help. Updates for WinRock can be obtained directly for free 

using the builtin ftp internet connection.  If an insurmountable problem occurs further technical support is 

available directly from Mineral Services; however, the software must be registered to receive support.   

 

                    MinServ (Mineral Services) 

                    5 Cassia Crt, Wantirna 

                    Vic, 3152, AUSTRALIA 

                    Ph: (03) 9887 2315 

                    Fax: (03) 9887 2315 

                    International: 

                    Ph: +61 3 9887 2315 

                    Fax: +61 3 9887 2315 

                    email: support@geologynet.com 

                    http://www.geologynet.com 
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Classification Diagrams 
 

 

   This is a list of all the classification diagrams. 

 

Plutonic Rocks 

Barker, 1979 ï An/Ab/Or, granites 

IUGS Carbonatites - CaO/MgO/FeO+Fe2O3+MnO carbonatites.  Contains >50% primary carbonates. 

IUGS Charnockites - Quartz/Alkali Feldspar/Plagioclase Charnockites.  Contains >5% hypersthene. 

IUGS Melilite Plutonic - Melilite/Olivine/Clinopyroxene melilite plutonic rocks. Contains > 10% melilite and 

<10% feldspathoids. 

IUGS General Plutonic QAP - Quartz/Alkali Feldspar/Plagioclase plutonic rocks.  Contains 0-90% mafic 

minerals. 

IUGS General Plutonic QAPF - Quartz/Alkali Feldspar/Plagioclase/Foids plutonic rocks.  Contains 0-90% 

mafic minerals. 

IUGS General Plutonic FAP - Foid/Alkali Feldspar/Plagioclase plutonic rocks. Contains 0-90% mafic 

minerals. 

Plutonic TAS ï K2O+Na2O vs SiO2 chemical classification for plutonic rocks.  Middlemost, 1994 

IUGS Mafic PlagPxOl - Plagioclase/Pyroxene/Olivine mafic rocks. Rocks falling into the gabbroic field of 

QAP diagram. 

IUGS Mafic PlagOpxCPx - Plagioclase/Orthopyroxene/Clinopyroxene mafic rocks.  Rocks falling into the 

gabbroic field of QAP diagram. 

IUGS Mafic Plag/Px/Hbl - Plagioclase/Pyroxene/Hornblende mafic rocks. Rocks falling into the gabbroic 

field of QAP diagram. 

IUGS Ultramafic Ol/OPx/CPx - Olivine/Orthopyroxene/Clinopyroxene ultramafic rocks.  Contains >90% 

mafic minerals. 

IUGS Ultramafic Ol/Px/Hbl - Olivine/Pyroxene/Hornblende ultramafic rocks. Contains >90% mafic 

minerals. 

 

Volcanic Rocks 

AFM Volcanic - K2O+Na2O/FeOt/MgO chemical classification for volcanic rocks. Irvin and Baragar, 1971 

IUGS Carbonatites - CaO/MgO/FeO+Fe2O3+MnO carbonatites. Contains > 50% primary carbonates. 

IUGS Melilite Volcanic - Melilite/Olivine/Clino-Pyroxene melilite volcanic rocks. Contains > 10% melilite 

and <10% feldspathoids 

IUGS Volcanic QAPF - Quartz/Alkali Feldspar/Plagioclase/Foids volcanic rocks. Contains 0-90% mafic 

minerals. 
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IUGS Volcanic QAP - Quartz/Alkali Feldspar/Plagioclase volcanic rocks. Contains 0-90% mafic minerals. 

IUGS Volcanic FAP - Foids/Alkali Feldspar/Plagioclase volcanic rocks. Contains 0-90% mafic minerals. 

IUGS Volcanic TAS - K2O+Na2O vs SiO2 chemical classification for volcanic rocks. Le Bas, 1986 

IUGS Volcanic TAS - K2O+Na2O vs SiO2 chemical classification for volcanic rocks. Middlemost, 1994 

Jensen Cation - Fet+Ti/Al/Mg chemical classification for volcanic rocks. Jensen, 1976, modified by 

Rollinson, 1993 

Winchester and Floyd, 1977 - Zr/TiO2 * 0.0001-SiO2, volcanic rocks 

Winchester and Floyd, 1977 ï Nb/Y-Zr/TiO2 * 0.0001, volcanic rocks 

 

Metamorphic Rocks 

Metamorphic - ACF - the ratio Na O + K O/CaO/FeO+MgO+MnO 

Metamorphic - A'KF - the ratio Na O + K O+CaO/K2O/FeO+MgO+MnO  

 

Sandstones 

General Sandstones - Quartz/Clay/Feldspar general sandstones. Selley, 1984 

Sandstones Arenites - Quartz/Feldspar/Rock Fragments for sandstones <15% clay. Pettijohn, 1975 

Sandstones Wackes - Quartz/Feldspar/Rock Fragments for sandstones >15% and <75% clay. Pettijohn, 

1975 

 

Tectonic Classification Granites 

Batchelor and Bowden, 1985 - R1=4*Si-11*(Na + K)-2*(Fe + Ti) vs R2=6*Ca+2*Mg+Al in millications, 

granites 

Harris et al, 1986 ï Rb/10,Hf,Ta*3, granites 

Pearce et al, 1984 - Y(ppm)+Nb(ppm) vs Rb(ppm), granites 

Pearce et al, 1984 ï Y(ppm) vs Nb(ppm), granites 

Pearce et al, 1984 - Ta(ppm)+Yb(ppm) vs Rb(ppm), granites  

Pearce et al, 1984 - Yb(ppm) vs Ta(ppm), granites 

 

Tectonic Classification Basalts 

Pearce and Cann, 1973 - Zr(ppm) vs Ti(ppm) , basalts 

Pearce and Cann, 1973 ï Ti(ppm)/100,Zr(ppm),Y(ppm)*3, basalts 

Pearce et al., 1977 - FeT, MgO, Al2O3, for rocks with SiO2 greater than 51 percent and less than 56 

percent,  basalts 

Meschede, 1986 ï 2*Nb,Zr/4,Y, basalts 

Mullen, 1983 - TiO2, 10xMnO 10xP2O5, with SiO2 greater than 45 percent and less than 54 percent, 

basalts 

 

Definitions 
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Mafic minerals = amphibole + pyroxene + olivine + mica + opaque minerals + epidote + allanite + garnet 

+ melilite + monticellite + primary carbonate + accessory minerals. 

 

Abbreviations used in the Rockname Table: 

M = mafic minerals 

An = anorthite 

Mel = melilite 

 

TAS Classification 

Q = Normative quartz 

Ol = Normative olivine
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